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1. INTRODUCTION TO THE LAB 

Introduction to Microsoft Word & Presentation, DOS,  DIA & Linux is divided into four sections. 

 

1. Microsoft Word & Presentation 

2. DOS 

3. DIA 

4. Linux  

        

Microsoft word and Presentation 

In this section,  Ms-Office will be  taken into details. Applications of Ms-Office which are taken 

into details according to the syllabus prescribed by G.G.S.I.P.U are: 

 

 Ms-Word 

 Ms-Excel 

 Ms-PowerPoint 

 

   

DOS 

 

In this section we will perform some internal and external commands. 

   

DIA    

 

In this  section, we will draw some flowcharts with the help of DIA. 

 

LINUX 

 

In this section we will come across some commands. 
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2.  Experiment list of Fundamentals of Computer 

 

Experiments on dismantling of PC. 

1. Dismantling the system unit , recognize all major components inside a PC 

,describe function of each component and define the relationship of internal 

components. 

Experiments on DOS: 

 2. Perform these commands internal commands. 

DIR,TYPE,DEL,ERASE,MD,CD,COPY,RMDIR,VER,DATE,TIME,PAT

H,CLS,RMDIR,VER,DATE,TIME,PATH,CLS,BREAK, SET,EXIT. 

3. Perform external commands. 

    APPEND,CHKDISK,ATTRIB,SYS,EDIT. 

 Experiments on system utilities 

 4. Explore and describe some system utility like regedit , memory                   

partioning, control panel, window tools. 

5. List various keys in registry and perform experiments to back up a key in 

registry using regedit. 

Experiments on linux 

6. Perform an experiment to install any rpm or debianlinux distribution    with 

emphasis on drive partitioning. 

7. Install rpm and deb packages. 

8. Perfom these commands in linux- chmod, su , chown, chgrp ,ls, 

mkdir,pwd,date,who, find, uname, wc, ifconfig. 

   9.  Create, open , edit, view file in linux. 

   10. Create user and group through CLI. 



 

MAIT/CSE                                                                                                                     5 | P a g e  

 

 

Experiments on Libre/Open Office Writer: 

 

11.  Create a office writer document and using tables distinguish between 

different types of memories. 

 

12.  Draft a letter asking for quotations of different peripheral devices for your 

computer lab and mail the letter using mail merge in open office writer. 

 

13.  Create a open office writer document and implement macro function. 

 

14.  Create a template and draw a basic block diagram of computer & using 

graphs compare the performance of different laptop/notebook PC.  

 

Experiments on Libre/Open Office Calc: 

15. Create a database of students, which contains marks obtained by students of a 

class in different subjects and then calculate maximum, minimum, average and 

sum of marks in each subject. Also calculate % of each student using functions and 

formulas in Libre/Open Office Calc also draw piechart and bar graph also. 

 

Experiments on Libre/Open Office Impress: 

16.  Make a simple presentation on your college, use 3D effects , animation on 

network topologies. 

Experiments on Dia: 

17. Write steps for making flowcharts in Dia and make a flow chart on    finding 

out largest among 3 numbers. 

18. Create a flow chart for finding factorial of a number using dia*. 

19.  Create flowchart for finding prime number using dia*.  
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Optional Experiments…. 

 

20. SQL Commands to create and insert into table, select data values from   table. 

21. SQL commands to alter/update/ delete data from table. 

22. Create HTML pages for your business website. 

23. Create HTML pages showing time table of trains departing from delhi      

railway station. 

24.  Create web pages for your college. 
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4. PROJECTS TO BE ALLOTED 

 (Beyond the syllabus prescribed by G.G.S.I.P.U) 

 
 

Students will be divided into a group of four and projects are allotted to those groups.  

This project is to be submitted at the end of the semester along with a project report by the 

individual student. 

 

List of projects given to the students is summarized as below: 

 

1. Simulation of any of the chemistry practical being performed by the student in the 

 chemistry lab. 

2. Simulation of any of the chemistry practical being performed by the student in the 

 Physics lab. 

3. Simulation of any of the chemistry practical being performed by the student in the 

 Mechanics lab. 

 

Students can select any of the above according to their choice but none of the student’s group 

should have the same practical for simulation. 

 

 

NOTE:        The project is to be made in some prog. Language only. If any other   

         programming language is used then the project will not be             

considered for evaluation. 
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5. FORMAT OF THE LAB RECORD TO BE        

 PREPARED BY THE STUDENTS 
 

 

 

1. The front page of the lab record prepared by the students should have a cover 

page as displayed below. 

 

NAME OF THE LAB 

Font should be (Size 20”, italics bold, Times New Roman) 

 

 

  

 

 Faculty name       Student name        Font 

should be (12”, Times Roman)     Roll No.: 

         Semester: 

         Group: 

       Font should be (12”, Times Roman) 

 

 

 

                                        

Maharaja Agrasen Institute of Technology, PSP Area, 

Sector – 22, Rohini, New Delhi – 110085 

Font should be (18”, Times Roman) 
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2. The second page in the record should be the index as displayed below. 

 

    INTRODUCTION TO COMPUTERS 

 

     PRACTICAL RECORD 

 

 

PAPER CODE  : ETCS - 157 

 

Name of the student  :  

 

University Roll No.  : 

 

Branch    : 

 

Section/ Group  : 

 

 

PRACTICAL DETAILS 

 

a) Experiments according to ITC lab syllabus prescribed by GGSIPU 

 

 

Exp. no 

 

 

Experiment Name 

 

Date of 

performance 

 

Date of 

checking 

 

Remarks 

 

Marks 

(10) 
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Exp. no 

 

 

Experiment Name 

 

Date of 

performance 

 

Date of 

checking 

 

Remarks 

 

Marks 

(10) 
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b) Experiments beyond the ITC lab syllabus prescribed by GGSIPU (Programming 

practical). 

 

 

Exp. no 

 

 

Experiment Name 

 

Date of 

performance 

 

Date of 

checking 

 

Remarks 

 

Marks 

(10) 
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PROJECT DETAILS 

 

1. TITLE      : 

2.  MEMBERS IN THE PROJECT GROUP : 

3.  PROJECT REPORT ATTACHED  : 

  a) YES   b) NO 

4.  SOFT COPY SUBMITTED   : 

  a) YES   b) NO     

Signature of the lecturer     Signature of the student 

 

(     )     (      ) 

 

3. Each practical which student is performing in the lab should have the following 

details in the respective sections:  

  Ms-Office 

a) AIM 

b) Date 

c) Procedure 

d) Input given  

e) Output 

f) Viva questions 

  HTML 

a) AIM 

b) Date 

c) Input given ( HTML code written) 

d) Output (Web page created) 

e) Viva questions 

  AutoCAD 

a) AIM 

b) Date 

c) Input given ( commands written at the command prompt) 



 

MAIT/CSE                                                                                                                     13 | P a g e  

 

d) Output (Figure created) 

e) Viva questions 

  C language 

a) AIM 

b) Date 

c) Logic of the program  

d) Input given ( code written )                          

e) Output  

f) Viva questions 

 

4. Project report should be added at last page. 
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6 . MARKING SCHEME  FOR THE  PRACTICAL 

EXAMS      

 

 

 
There will be two practical exams in each semester.  

 

 Internal Practical Exam  

 External Practical Exam 

 

 

INTERNAL PRACTICAL EXAM 

 

It is taken by the concerned lecturer of the batch.  

 
MARKING SCHEME FOR THIS EXAM IS: 

 

Total Marks: 40 

 

Division of 40 marks is as follows  

 

1. Regularity:     25  

 

 Performing program in each turn of the lab 

 Attendance of the lab 

 File 

 

2. Viva Voice:     10 

 

3. Project:      5 

 

 

NOTE:  For the regularity, marks are awarded to the student out of 10 for each   

 experiment performed in the lab and at the end the average marks are   

 giving out of 25.  
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EXTERNAL PRACTICAL EXAM 

 

It is taken by the concerned lecturer of the batch and by an external examiner. In this exam 

student needs to perform the experiment allotted at the time of the examination, a sheet will 

be given to the student in which some details asked by the examiner needs to be written and 

at the last viva will be taken by the external examiner. 
 

MARKING SCHEME FOR THIS EXAM IS: 

 

Total Marks: 60 

 

Division of 60 marks is as follows  

 

1. Sheet filled by the student:   20  

 

2. Viva Voice:     15 

 

3. Experiment performance:   15 

 

4. File submitted:     10 

 

 

 

NOTE:   
 

 Internal marks + External marks = Total marks given to the students  
     (40 marks)    (60 marks)              (100 marks) 

 

 Experiments given to perform can be from any section of the lab. 
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7.  Details of the each section of the lab along with the example exercise & 

expected viva questions.  

 
 

AIM : Dismantling of a Computer. 

 

1. Hard drive 

Alternatively referred to as a hard disk drive and abbreviated as HD or HDD, the hard drive is 

the computer's main storage media device that permanently stores all data on the computer. The 

hard drive was first introduced on September 13, 1956and consists of one or more hard 

drive platters inside of an air sealed casing. Most computer hard drives are in an internal drive 

bay at the front of the computer and connect to the motherboard using either an ATA, SCSI, 

or SATA cable and power cable. Below is a picture of what the inside of a hard drive looks like 

for a desktop and laptop hard drive. 

 

http://www.computerhope.com/jargon/c/computer.htm
http://www.computerhope.com/history/194060.htm
http://www.computerhope.com/jargon/p/platter.htm
http://www.computerhope.com/jargon/i/internal.htm
http://www.computerhope.com/jargon/d/drivebay.htm
http://www.computerhope.com/jargon/d/drivebay.htm
http://www.computerhope.com/jargon/m/mothboar.htm
http://www.computerhope.com/jargon/a/ata.htm
http://www.computerhope.com/jargon/s/scsi.htm
http://www.computerhope.com/jargon/s/sata.htm
http://www.computerhope.com/jargon/l/laptop.htm
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As can be seen in the above picture, the desktop hard drive consists of the following 

components: the head actuator, read/write actuator arm, read/write head, spindle, andplatter. On 

the back of a hard drive is a circuit board called the disk controller. 

Tip: New users often confuse memory (RAM) with disk drive space. See our memory 

definition for a comparison between memory and storage. 

How is data read and stored on a hard drive? 

Data sent to and from the hard drive is interpreted by the disk controller, which tells the hard 

drive what to do and how to move the components within the drive. When the operating system 

needs to read or write information, it examines the hard drive's File Allocation Table (FAT) to 

determine file location and available areas. Once this has been determined, the disk controller 

instructs the actuator to move the read/write arm and align the read/write head. Because files are 

often scattered throughout the platter, the head needs to move to different locations to access all 

information. 

All information stored on a traditional hard drive, like the above example, is done magnetically. 

After completing the above steps, if the computer needs to read information from the hard drive, 

it would read the magnetic polarities on the platter. One side of the magnetic polarity is 0 and the 

other is 1. Reading this as binary data, the computer can understand what the data is on the 

platter. For the computer to write information to the platter, the read/write head aligns the 

magnetic polarities, writing 0's and 1's that can be read later. 

External and Internal hard drives 

Although most hard drives are internal hard drives, many users also use external hard 

drives to backup data on their computer and expand the total amount of space available to them. 

External drives are often stored in an enclosure that helps protect the drive and allow it to 

interface with the computer, usually over USB or eSATA. A great example of a backup external 

device that supports multiple hard drives is theDrobo. 

 

 

 

 

http://www.computerhope.com/jargon/a/actuator.htm
http://www.computerhope.com/jargon/a/aarm.htm
http://www.computerhope.com/jargon/h/head.htm
http://www.computerhope.com/jargon/s/spindle.htm
http://www.computerhope.com/jargon/p/platter.htm
http://www.computerhope.com/jargon/d/diskcont.htm
http://www.computerhope.com/jargon/m/memory.htm
http://www.computerhope.com/jargon/m/memory.htm
http://www.computerhope.com/jargon/d/diskcont.htm
http://www.computerhope.com/jargon/f/fat.htm
http://www.computerhope.com/jargon/b/binary.htm
http://www.computerhope.com/jargon/e/enclosur.htm
http://www.computerhope.com/jargon/u/usb.htm
http://www.computerhope.com/jargon/s/sata.htm
http://www.computerhope.com/jargon/d/drobo.htm
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2. RAM 

Alternatively referred to as main memory, primary memory, or system memory, Random 

Access Memory (RAM) is a computer storage location that allows information to be stored and 

accessed quickly from random locations within DRAM on a memory module. Because 

information is accessed randomly instead of sequentially like a CD or hard drive the computer 

can access the data much faster than it would if it was only reading the hard drive. However, 

unlike ROM and the hard drive RAM is a volatile memory and requires power in order to keep 

the data accessible, if power is lost all data contained in memory lost. 

As the computer loads parts of the operating system and drivers are loaded into memory, which 

allows the CPU to process the instructions much faster and your computer to load faster. After 

the operating system has loaded, each program you open such as the browser you're using to 

view this page is loaded into memory while it is running. If too many programs are open the 

computer will swap the data in the memory between the RAM and the hard disk drive. 

Over the evolution of computers there has been different variations of RAM used in computer. 

Some of the more common examples are DIMM, RIMM, SIMM, SO-DIMM, andSOO-RIMM. 

Below is an example image of a 512MB DIMM computer memory module and what the typical 

desktop computer memory card will look like. This memory module would be installed 

into memory slots on the motherboard. 

 
 

 

 

 

 

 

http://www.computerhope.com/jargon/d/dram.htm
http://www.computerhope.com/jargon/m/memory-module.htm
http://www.computerhope.com/jargon/c/cd.htm
http://www.computerhope.com/jargon/h/harddriv.htm
http://www.computerhope.com/jargon/r/rom.htm
http://www.computerhope.com/jargon/v/volamemo.htm
http://www.computerhope.com/jargon/c/cpu.htm
http://www.computerhope.com/jargon/s/swapfile.htm
http://www.computerhope.com/jargon/d/dimm.htm
http://www.computerhope.com/jargon/r/rimm.htm
http://www.computerhope.com/jargon/s/simm.htm
http://www.computerhope.com/jargon/d/dimm.htm
http://www.computerhope.com/jargon/r/rimm.htm
http://www.computerhope.com/jargon/d/dimm.htm
http://www.computerhope.com/jargon/m/memoslot.htm
http://www.computerhope.com/jargon/m/mothboar.htm
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3. Memory slot 

A memory slot, memory socket, or RAM slot is what allows computer memory (RAM) to be 

inserted into the computer. Depending on the motherboard, there may be 2 to 4 memory 

slots (sometimes more on high-end motherboards) and are what determine the type of RAM used 

with the computer. The most common types of RAM are SDRAM and DDR for desktop 

computers and SODIMM for laptop computers, each having various types and speeds. In the 

picture below, is an example of what memory slots may look like inside a desktop computer. In 

this picture, there are three open available slots for three memory sticks. 

 

When buying a new computer or motherboard, pay close attention to the types of RAM the 

memory slots, so you are familiar with what type of RAM to buy for your computer. It is also 

important to note how many available memory slots are available in your computer. It is not 

uncommon for some computers to have all memory slots occupied, which means if you wanted 

to upgrade your computer memory some or all of the memory currently installed would need to 

be removed first. 

 

 

 

 

 

 

 

http://www.computerhope.com/jargon/r/ram.htm
http://www.computerhope.com/jargon/m/mothboar.htm
http://www.computerhope.com/jargon/s/sdram.htm
http://www.computerhope.com/jargon/d/ddr.htm
http://www.computerhope.com/jargon/d/dimm.htm
http://www.computerhope.com/jargon/l/laptop.htm


 

MAIT/CSE                                                                                                                     20 | P a g e  

 

4 .CPU 

Note: Many new computer users may improperly call their computer and sometimes 

their monitor the CPU. When referring to your computer or monitor it is proper to refer to them 

as either the "computer" or "monitor" and not CPU. 

Alternatively referred to as the brain of the computer, processor, central processor, 

or microprocessor, the CPU (pronounced as C-P-U) was first developed at Intel with the help 

of Ted Hoff in the early 1970's and is short for Central Processing Unit. The computer CPU is 

responsible for handling all instructions it receives from hardware and software running on the 

computer. 

In the picture below, is an example of what the top and bottom of an Intel Pentiumprocessor 

looks like. The processor is placed and secured into a compatible CPU socketfound on 

the motherboard, and because of the heat it produces it is covered with a heat sink to help keep it 

cool and running smoothly. 

http://www.computerhope.com/jargon/c/computer.htm
http://www.computerhope.com/jargon/m/monitor.htm
http://www.computerhope.com/comp/intel.htm
http://www.computerhope.com/people/marcian_hoff.htm
http://www.computerhope.com/jargon/c/compinst.htm
http://www.computerhope.com/jargon/h/hardware.htm
http://www.computerhope.com/jargon/s/software.htm
http://www.computerhope.com/jargon/p/pentium.htm
http://www.computerhope.com/jargon/s/socket.htm
http://www.computerhope.com/jargon/m/mothboar.htm
http://www.computerhope.com/jargon/h/heatsink.htm
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As can be seen by the above picture, the CPU chip is usually in the shape of a square or rectangle 

and has one notched corner to help place the chip into the computer properly. On the bottom of 

the chip are hundreds of connector pins that plug into each of the corresponding holes on the 

socket. Today, most CPU's resemble the picture shown above; however, Intel and AMD have 

also experimented with slot processors that were much larger and slid into a slot on the 

motherboard. Also, over the years there have been dozens of different types of sockets on 

motherboards, each socket only supports so many different processors, and each has its own pin 

layout. 

http://www.computerhope.com/comp/intel.htm
http://www.computerhope.com/comp/amd.htm
http://www.computerhope.com/jargon/s/slot.htm
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In the CPU, the primary components are the ALU (Arithmetic Logic Unit) that performs 

mathematical, logical, and decision operations and the CU (Control Unit) that directs all of the 

processors operations. Over the history of computer processors, the speed (clock speed) and 

capabilities of the processor have dramatically improved. For example, the first microprocessor 

was the Intel 4004 that was released November 15, 1971 and had 2,300 transistors and 

performed 60,000 operations per second. The Intel Pentium Processor shown on this page has 

3,300,000 transistors and performs around 188,000,000 instructions per second. 

 

 

5. Heat sink 

A heat sink is an electronic device that incorporates either afan or 

a peltier device to keep a hot component such as aprocessor cool. There are two heat sink 

types: active andpassive. 

Active heat sinks utilize power and are usually a fan type or some other peltier cooling device. 

If you are looking to purchase an active heat sink, it is recommended that you purchase fans with 

ball-bearing motors that often last much longer than sleeve bearings. Sometimes these types of 

heat sinks are referred to as a HSF, which is short for heat sink and fan. 

Passive heat sinks are 100% reliable, as they have no mechanical components. Passive heat 

sinks are made of an aluminum-finned radiator that dissipates heat through convection. For 

Passive heat sinks to work to their full capacity, it is recommended that there is a steady air flow 

moving across the fins. The above picture is an example of a heat sink that is both active and 

passive. 

 

 

http://www.computerhope.com/jargon/a/alu.htm
http://www.computerhope.com/jargon/c/contunit.htm
http://www.computerhope.com/jargon/c/clockspe.htm
http://www.computerhope.com/jargon/num/4004.htm
http://www.computerhope.com/history/196080.htm
http://www.computerhope.com/jargon/t/transist.htm
http://www.computerhope.com/jargon/d/device.htm
http://www.computerhope.com/jargon/f/fan.htm
http://www.computerhope.com/jargon/c/cpu.htm
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6.Capacitor 

A capacitor is a component made of two or sets of two 

conductive plates with a thin insulator between them and wrapped in a ceramic and plastic 

container. When the capacitor receives a direct current (DC), a positive charge builds up on one 

of the plates (or set of plates) while a negative charge builds up on the other. This charge, which 

is measured in microfarads on a computer capacitor, remains in the capacitor until it is 

discharged. In the image to the right, is an example of what a capacitor may look like on a 

computermotherboard. 

http://www.computerhope.com/jargon/d/dc.htm
http://www.computerhope.com/jargon/m/mothboar.htm
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Another common type of capacitor is an electrolytic capacitor, 

which is a higher capacitance capacitor in a smaller package. In the bottom picture to the right, is 

a picture and an example of these types of capacitors. 

Like any other component in a computer, capacitors in a computer can fail, and when they do 

can cause the computer or the component to fail. In the case of a motherboard, when a 

motherboard capacitor fails the computer will no longer boot, and the capacitor needs to be 

replaced or a new motherboard needs to be put in the computer. 

 

7.Power Supply 
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1. Short for Power Supply and sometimes abbreviated as PSU, which is short for Power Supply 

Unit. The PS is an internal hardware component used to supply the components in 

acomputer with power by converting potentially lethal 110-115 or 220-230 volt alternating 

current (AC) into a steady low-voltage direct current (DC) usable by the computer. A power 

supply is rated by the number of watts it generates. For example, the image to the right, is of 

an AntecTrue 330, a 330 Watt power supply and an example of what a computer power supply 

looks like. 

Caution: Do not open the power supply, it contains capacitors that are capable of holding hold 

electricity even if the computer is off and unplugged for a week, if not longer. 

On the back end of the power supply as shown in the above picture is where you connect 

the power cord to the computer. In addition to the power cord connection the back also has an 

fan opening to draw air out of the power supply, a small red switch to change the power supply 

voltage, and the rocker switch to turn the power supply on and off. 

On the front-end, which is not visible unless the computer is opened is several dozen other cables 

that connect the power supply to each of the devices and the computermotherboard.  

 

8. IC 

1. Alternatively referred to as a bare chip, monolithic integrated 

circuit, or microchip, IC is short for Integrated Circuit orIntegrated Chip and was first 

introduced as a concept byGeoffrey Dummer a British radar engineer on May 7, 1952 and later 

successfully developed by Jack Kilby and Robert Noyceand first demonstrated September 

12, 1958. The IC is a package containing many circuits, pathways, transistors, and other 

electronic components all working together to perform a particular function or a series of 

functions. Integrated circuits are the building blocks of computer hardware. The picture is an 

example of what an Integrated Circuit may look like on a circuit board today. 

 

http://www.computerhope.com/jargon/c/computer.htm
http://www.computerhope.com/jargon/a/ac.htm
http://www.computerhope.com/jargon/d/dc.htm
http://www.computerhope.com/comp/antec.htm
http://www.computerhope.com/jargon/w/watt.htm
http://www.computerhope.com/jargon/c/capacito.htm
http://www.computerhope.com/jargon/p/powecord.htm
http://www.computerhope.com/jargon/r/rocker-switch.htm
http://www.computerhope.com/jargon/m/mothboar.htm
http://www.computerhope.com/people/geoffrey_dummer.htm
http://www.computerhope.com/history/194060.htm
http://www.computerhope.com/people/jack_kilby.htm
http://www.computerhope.com/people/robert_noyce.htm
http://www.computerhope.com/history/194060.htm
http://www.computerhope.com/jargon/t/transist.htm
http://www.computerhope.com/jargon/h/hardware.htm
http://www.computerhope.com/jargon/p/pcb.htm
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9. PCI 

Short for Peripheral Component Interconnect, PCI was introduced by Intel in1992, revised 

in 1993 to version 2.0, and later revised in 1995 to PCI 2.1 and is as an expansion to the ISA bus. 

The PCI bus is a 32-bit (133MBps) computer bus that is also available as a 64-bit bus and was 

the most commonly found and used computer bus in computers during the late 1990's and early 

2000's. Unlike, ISA and earlier expansion cards, PCI follows the PnP specification and therefore 

does not require any type of jumpers or dip switches. Below is an example of what the PCI slots 

looks like on a motherboard. In the picture, there are three PCI slots, PCI4, PCI5, and PCI6. 

 

Today's computers and motherboards have replaced PCI with PCI Express (PCIe) slots. 

http://www.computerhope.com/comp/intel.htm
http://www.computerhope.com/history/1992.htm
http://www.computerhope.com/history/1993.htm
http://www.computerhope.com/history/1995.htm
http://www.computerhope.com/jargon/i/isa.htm
http://www.computerhope.com/jargon/num/32bit.htm
http://www.computerhope.com/jargon/num/64bit.htm
http://www.computerhope.com/jargon/p/pnp.htm
http://www.computerhope.com/jargon/j/jumper.htm
http://www.computerhope.com/jargon/d/dipswitc.htm
http://www.computerhope.com/jargon/p/pciexpre.htm
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Examples of PCI devices 

 Modem 

 Network card 

 Sound card 

 Video card 

 

 

PCI device drivers 

If you are looking for PCI drivers, you most likely need to get the drivers for the installed PCI 

device. For example, if you need a PCI Ethernet adapter driver you need the drivers for the PCI 

network card. See our drivers section for all computer drivers. 

 

 

10. AGP 

Short for Accelerated Graphics Port, AGP is an advanced port designed for Video cards and 

3D accelerators. Designed by Intel and introduced in August of 1997, AGP introduces a 

dedicated point-to-point channel that allows the graphics controller direct access the 

system memory. Below is an illustration of what the AGP slot may look like on 

your motherboard. 

 

The AGP channel is 32-bits wide and runs at 66 MHz. This translates into a total bandwidth of 

266 MBps, which is much greater than the PCI bandwidth of up to 133 MBps. AGP also 

supports two optional faster modes, with throughput of 533 MBps and 1.07 GBps. It also allows 

3-D textures to be stored in main memory rather than video memory. 

Each computer with AGP support will either have one AGP slot or on-board AGP video. If you 

needed more than one video card in the computer, you can have one AGP video card and one 

PCI video card or use a motherboard that supports SLI. 

http://www.computerhope.com/jargon/m/modem.htm
http://www.computerhope.com/jargon/n/nic.htm
http://www.computerhope.com/jargon/s/souncard.htm
http://www.computerhope.com/jargon/v/videadap.htm
http://www.computerhope.com/drivers/index.htm
http://www.computerhope.com/comp/intel.htm
http://www.computerhope.com/history/1997.htm
http://www.computerhope.com/jargon/m/memory.htm
http://www.computerhope.com/jargon/m/mothboar.htm
http://www.computerhope.com/jargon/num/32bit.htm
http://www.computerhope.com/jargon/m/mhz.htm
http://www.computerhope.com/jargon/m/mbps.htm
http://www.computerhope.com/jargon/o/onboard.htm
http://www.computerhope.com/jargon/s/sli.htm
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AGP is available in three different versions, the original AGP version mentioned above,AGP 

2.0 that was introduced in May of 1998, and AGP 3.0 (AGP 8x) that was introduced in 

November of 2000. AGP 2.0 added 4x signaling and was capable of operating at 1.5V and AGP 

3.0 was capable of double the transfer speeds. 

Tip: Not all operating systems support AGP because of limited or no driver support. For 

example, Windows 95 did not incorporate AGP support. See the Windows versions pagefor 

information about Windows versions that support AGP. 

Today, AGP is being replaced by PCI Express. 

 

 

11. Resistors 

 

 

One of the most commonly found components in an electronic circuit. Resistors help restrict and 

impede a current flow. The picture shows examples of resistors on a motherboard. In this picture 

the resistors are R92 and R93 and marked with 222 

 

 

 

12 .CMOS 

http://www.computerhope.com/history/1998.htm
http://www.computerhope.com/history/2000.htm
http://www.computerhope.com/whow.htm
http://www.computerhope.com/jargon/p/pciexpre.htm
http://www.computerhope.com/jargon/m/mothboar.htm
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1 

Alternatively referred to as a Real-Time Clock (RTC), Non-Volatile RAM 

(NVRAM) or CMOS RAM, CMOS is short for Complementary Metal-Oxide 

Semiconductor. CMOS is an on-board semiconductor chip powered by a CMOS battery inside 

computers that stores information such as the system time and date and the system hardware 

settings for your computer. The picture shows an example of the most common CMOS coin cell 

battery used in a computer to power the CMOS memory. 

A Motorola 146818 chip was the first RTC and CMOS RAM chip to be used in early IBM 

computers. The chip was capable of storing a total of 64 bytes of data. Since the system clock 

used 14 bytes of RAM, this left an additional 50 bytes of space that was available for IBM to 

store system settings. Today, most computers have moved the settings from a separate chip and 

incorporated them into the southbridge or Super I/O chips. 

   

 

 

 

 

13.  SATA 

http://www.computerhope.com/jargon/s/soutbrid.htm
http://www.computerhope.com/jargon/s/sio.htm


 

MAIT/CSE                                                                                                                     30 | P a g e  

 

 

 

Short for SerialATA, SATA 1.0 was first released in August2001 and is a replacement for the 

Parallel ATA interface used in IBM compatible computers. SerialATA is capable of delivering 

1.5Gbps (150MBps) of performance to each drive within a disk array, offers backwards 

compatibility for existing ATA and ATAPI devices, and offers a thin, small cable solution as 

seen in the picture. This cable helps make a much easier cable routing and offers better airflow in 

the computer when compared to the earlier ribbon cables used with ATA drives. 

 

 

http://www.computerhope.com/history/2001.htm
http://www.computerhope.com/jargon/g/gbps.htm
http://www.computerhope.com/jargon/m/mbps.htm
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In addition to being an internal solution SATA also supports external drives through External 

SATA more commonly known aseSATA. eSATA offers many more advantages when compared 

to other solutions. For example, it is hot-swappable, supports faster transfer speeds and no 

bottleneck issues when compared with other popular external solutions such 

as USB and Firewire, and supports disk drive technologies such as S.M.A.R.T.. 

Unfortunately, however, eSATA does have some disadvantages such as not distributing power 

through the cable like USB, which means drives will require an external power source and it 

only supports a maximum cable lengths of up to 2m. Because of these disadvantages don't plan 

on eSATA becoming the only external solution for computers. 

  

 

14  IDE 

Short for Integrated Drive Electronics or IBM Disc Electronics, IDE is more commonly 

known as ATA or Parallel ATA (PATA) and is a standard interface for IBM compatible hard 

drives. IDE is different from the Small Computer Systems Interface (SCSI) and Enhanced Small 

Device Interface (ESDI) because its controllers are on each drive, meaning the drive can connect 

directly to the motherboard or controller. IDE and its updated successor, Enhanced IDE (EIDE), 

are the most common drive interfaces found in IBM compatible computers today. Below, is a 

picture of the IDE connector on the back of a hard drive, a picture of what an IDE cable looks 

like, and the IDE channels it connects to on the motherboard. 

 

http://www.computerhope.com/jargon/h/hotswapp.htm
http://www.computerhope.com/jargon/u/usb.htm
http://www.computerhope.com/jargon/f/firewire.htm
http://www.computerhope.com/jargon/s/smart.htm
http://www.computerhope.com/jargon/m/meter.htm
http://www.computerhope.com/jargon/a/ata.htm
http://www.computerhope.com/jargon/s/scsi.htm
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15.Floppy disk 

 

 

Alternatively referred to as a floppy or floppy disk, a floppy diskette was originally created 

in1967 by IBM to help have an alternative to buying hard drives that were extremely expensive 

at the time and were not thought of as something to be used with a standard computer. Below is a 

brief history of each of three major floppy diskettes. 

 

http://www.computerhope.com/history/196080.htm
http://www.computerhope.com/comp/ibm.htm
http://www.computerhope.com/jargon/h/harddriv.htm
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How were floppy disks used? 

Early computers did not have CD-ROM drives or USB, and floppy disks were the only way to 

install a new program onto a computer or backup your information. If the program was small 

(less than 1.44MB for the 3.5" floppy disk) the program could be installed from one floppy disk. 

However, since most programs were larger than 1.44MB most programs required multiple floppy 

diskettes. For example, the diskette version of Windows 95 came on 13 DMF diskettes and had 

to be installed one disk at a time. 

Are floppy diskettes still used today? 

There are still a few diehards who are still using floppy diskettes, some governments still even 

use 8" floppy diskettes. However, since the early 2000s computers started to no longer ship with 

floppy disk drives as users started moving to CD-R and Zip drives to store their information 

since they could hold a lot more information. 

 

16. CD-ROM 

 

Short for Compact Disc-Read Only Memory, a CD-ROM(shown right) is an optical 

disc which contains audio or software data whose memory is read only. A CD-ROM 

Driveor optical drive is the device used to read them. CD-ROM drives have speeds ranging 

from 1x all the way up to 72x, meaning it reads the CD roughly 72 times faster than the 1x 

version. As you would imagine, these drives are capable playing audio CDs and reading data 

CDs. Below is a picture of the front and back of a standard CD-ROM drive. 

http://www.computerhope.com/jargon/c/cdrom.htm
http://www.computerhope.com/jargon/u/usb.htm
http://www.computerhope.com/jargon/d/dmf.htm
http://www.computerhope.com/jargon/c/cdr.htm
http://www.computerhope.com/jargon/z/zipdrive.htm
http://www.computerhope.com/jargon/c/compactd.htm
http://www.computerhope.com/jargon/c/compactd.htm
http://www.computerhope.com/jargon/r/readonly.htm
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17.USB 
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Short for Universal Serial Bus, USB is a standard that was introduced 

in 1995 by Intel, Compaq, Microsoft and other computer companies. USB 1.x is an 

external bus standard that supports data transfer rates of 12 Mbps and is capable of supporting up 

to 127 peripheral devices. The picture shows an example of a USB cable being connected into 

the USB port. 

 

18.Mouse/keyboard port 

 

1. Often referred to as the mouse port or keyboard port, the PS/2 port was developed 

by IBM and is used to connect a computer mouse or keyboard to an IBM compatible computer. 

http://www.computerhope.com/history/1995.htm
http://www.computerhope.com/comp/intel.htm
http://www.computerhope.com/comp/compaq.htm
http://www.computerhope.com/comp/msoft.htm
http://www.computerhope.com/jargon/b/bus.htm
http://www.computerhope.com/jargon/d/datatran.htm
http://www.computerhope.com/jargon/m/mbps.htm
http://www.computerhope.com/jargon/p/peripher.htm
http://www.computerhope.com/comp/ibm.htm
http://www.computerhope.com/jargon/m/mouse.htm
http://www.computerhope.com/jargon/k/keyboard.htm
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The PS/2 port is a mini DIN plug that contains six pins and is still found on all IBM compatible 

computers today, however, is starting to be replaced byUSB. 

The picture to shows what the PS/2 ports may look like on the back of your computer. As can be 

seen by both of these pictures many computers have adopted the color codes purple and teal as 

identifications for each of the port. The mouse is teal and the keyboard is purple. 

Below, the left picture is an example of the PS/2 plug and the right illustration is of the actual 

PS/2 connection with its pin layouts. 

 

 

19 Parallel port 

Less commonly referred to as the Centronics interface or Centronics connectorafter the 

company that originally designed it, the port was later developed by Epson. The parallel port is 

found on the back of IBM compatible computers and is a 25-pin (type DB-25) computer 

interface commonly used to connect printers to the computer. Below is an example of the DB25 

interface found on the back of the computer. 

 

Identifying 

In the above graphic of a parallel port you can notice the DB25 parallel port connection is easy to 

identify and is often the biggest connection on the back of the computer. The connection is in the 

shape of the letter D, is a female connector, and has 25 holes. 

Parallel port modes 

http://www.computerhope.com/jargon/d/din.htm
http://www.computerhope.com/jargon/u/usb.htm
http://www.computerhope.com/comp/epson.htm
http://www.computerhope.com/jargon/f/femaleco.htm
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The computer is capable of having the parallel port run at different modes depending on your 

needs and available resources. Some of these modes include: IEEE-1284(Auto), Centronics 

mode, Nibble mode, Unidirectional (SPP), Bi-directional, EPP, andECP. 

 

 

20. Serial port 

 

An Asynchronous port on the computer used to connect 

a serial device to the computer and capable of transmitting one bit at a time. Serial ports are 

typically identified on IBM compatible computers as COM (communications) ports. For 

example, a mouse might be connected to COM1 and a modem to COM2. With the introduction 

of USB, FireWire, and other faster solutions serial ports are rarely used when compared to how 

often they've been used in the past. The picture shows the DB9 serial port on the back of a 

computer. 

Identifying 

In the above graphic of a serial port you can notice the DB9 serial port connection is easy to 

identify. The connection is in the shape of the letter D, is a male connector, and has 9 pins. 

Pin information 

Below is a listing of each of the pins located on the DB9 connector, their purpose, and signal 

name. As can be seen in the above picture pin one is in the top left and pin 9 is in the bottom 

right. 

 

 

 

21. LAN port 

http://www.computerhope.com/jargon/i/ieee1284.htm
http://www.computerhope.com/jargon/c/centmode.htm
http://www.computerhope.com/jargon/c/centmode.htm
http://www.computerhope.com/jargon/n/nibblemo.htm
http://www.computerhope.com/jargon/u/unidirec.htm
http://www.computerhope.com/jargon/b/bidirect.htm
http://www.computerhope.com/jargon/e/epp.htm
http://www.computerhope.com/jargon/e/ecp.htm
http://www.computerhope.com/jargon/ja.htm
http://www.computerhope.com/jargon/c/computer.htm
http://www.computerhope.com/jargon/u/usb.htm
http://www.computerhope.com/jargon/f/firewire.htm
http://www.computerhope.com/jargon/m/maleconn.htm
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Alternatively referred to as an Ethernet port, network 

connection, and network port, the LAN port is a port connection that allows a computer to 

connect to a network using a wired connection. The picture is a close up example of what a LAN 

port looks like for a network cable using a RJ-45 connector. In the case of this example, the two 

led lights will blink when that port is active and receiving activity. 

 

 

22 . Sound card 

 

Alternatively referred to as a sound board or an audio card, a sound card is anexpansion 

card or integrated circuit that provides a computer with the ability to produce sounds that can be 

heard by the user either over speakers or headphones. Below is an image of the Creative Sound 

Blaster sound card and an example of what a sound card that connects to an expansion slot inside 

your computer may look like. 

 

http://www.computerhope.com/jargon/e/expacard.htm
http://www.computerhope.com/jargon/e/expacard.htm
http://www.computerhope.com/jargon/i/integrat.htm
http://www.computerhope.com/jargon/s/speaker.htm
http://www.computerhope.com/jargon/h/headphon.htm
http://www.computerhope.com/comp/creative.htm
http://www.computerhope.com/jargon/e/expaslot.htm
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The computer sound card is considered a peripheral, although the computer does not need a 

sound card to function almost every computer today will include a sound card in the expansion 

slot or on the motherboard (onboard). 

http://www.computerhope.com/jargon/p/peripher.htm
http://www.computerhope.com/jargon/m/mothboar.htm
http://www.computerhope.com/jargon/o/onboard.htm
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            AIM:                 TO PERFORM THESE COMMANDS ON DOS 

INTERNAL COMMANDS :      SET, PATH, DIR, MD, CD, CD..,BREAK 

            EXTERNAL COMMANDS:     ATTRIB,TREE,CHKDSK,APPEND 

 

 

1. DIR 

C:\>DIR 

 

 

 

 

 

 

 

 

 

 

 

2.  CD 

 

C:\>USERS>CD.. 
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3. TYPE 

D:\>TYPE  TRY.TXT 

 

 

 

 

4. DEL 

D:\>DEL TRY.TXT 
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5.  MD 

D:\>MD STUDENT 

 

 

 

 

 

 

 

 

 

 

 

 

Copy 
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6.  RMDIR 

D:\>RMDIR STUDENT 
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8) VER, DATE, TIME 

D:\>VER 

D:\>DATE 

D:\>TIME 

 

 

9) COPY CON  

D:\>COPY CON 

 

 

10) SET, PATH 

D:\>PATH 

D:\>SET 
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TREE 

C:\>TREE 
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APPEND 

C:\>APPEND 

 

ATTRIB 

C:\>DOCUME~1>USER4>ATTRIB 
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HOW TO WORK IN DIA 
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Chapter 1. Introduction 

 

1.1. Introduction 

 

Dia is an application for creating technical diagrams. Its interface and features are loosely 

patterned after the Windows program Visio. Features of Dia include multiple-page printing, 

export to many formats (EPS, SVG, CGM and PNG), and the ability to use custom shapes 

created by the user as simple XML descriptions. Dia is useful for drawing UML diagrams, 

network maps, and flowcharts. 

This document describes version 0.97 of Dia. 

 

 

Chapter 2. Quickstart 

 

The Dia Quickstart is designed to help you get started creating diagrams with Dia without having 

to read a manual. 

2.1. What Can You Do? 

Dia is a diagramming application that can be used to make a large variety of diagrams. Dia is 

easy to learn and flexible enough to allow power users to create highly customized diagrams. 

 

2.4. Making a Diagram 

A diagram is made up of objects. Objects are shapes or lines that can be different colors and 

sizes. Objects can be simple line drawings, text, or full-color pictures. Some objects allow text to 

be entered inside the shape. Using Dia to create a diagram is easy. The Toolbox contains a 

palette of predefined objects, including simple shapes, lines, and specialized objects. To add an 

object to the canvas, simply click on the desired object's icon on the Toolbox and then click on 

the desired point on the canvas. The object will appear on the canvas where you clicked. See 

Adding Objects for more information. 

An object can be moved by clicking on the object and dragging the mouse. The object can be 

resized by clicking and dragging one of the object's green or red "handles". See Moving Objects 

and Resizing Objects can be connected using lines. Just drag each end of a line to any connection 

point (small blue "x") on an object. Once objects are connected, they can be moved and the line 

stretches to keep them connected. In the Toolbox, you can double-click on any object's icon to 

view and edit the object's default properties. 

This allows you to customize various default properties of each object. Dia includes a set of 

standard shape and line objects. See Objects for more information on working with the standard 

objects. Dia includes a large number of predefined objects for various uses. These include 

flowcharts, UML diagrams, network diagrams, and many others. See Special Object Categories 

for more information on the various objects available. Many common tasks in Dia require 

selecting one or more objects. Dia includes a number of ways to select objects quickly. See 

Selecting Objects for more information. Quickstart 4 Dia can be customized in a number of 

ways. See Customization for more information on customization. Layers create multiple-images 

so they are one image. By doing this, a user can edit one layer without 

worrying about affecting any of the other layers. See Managing Layers for more information on 

working with layers. Dia is designed to make adding new user-defined shapes very easy. See 

Custom Shape Module for more information on creating your own custom shapes. 
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2.5. Saving and Printing Your Diagram 

 

Dia provides the normal save and print options, located on the File menu. Selecting the File -> 

Page Setup allows you to set the paper size, orientation, and print margins. This also allows you 

to choose whether to print the diagram to scale (entered in percent) or to fit the diagram to a 

specific size (in centimeters) 

. 

2.6. Running Dia From the Command Line 
Dia can be run from the command line. This allows certain Dia capabilities to be used in batch 

script files. See Dia Command Line for more information on creating your own custom shapes. 

 

 

Chapter. The Canvas 

 

3.1. Canvas Introduction 

The Dia canvas is the window that contains the diagram. All of the user's objects are placed and 

arranged on the canvas. 

 

3.2. Grid Lines 

Grid lines are similar to the lines on graph paper. They allow the user to easily align objects on 

the canvas. If the Dynamic grid box is checked, the grid adjusts automatically to keep the same 

visible spacing as the diagram view is zoomed in or out. Also, when this box is checked, the 

other options on the dialog are disabled. If the Dynamic grid box is unchecked, then the grid 

spacing remains the same in absolute terms. So when 

the view is zoomed out, the grid appears smaller, and when the view is zoomed in, the grid 

appears larger. The Spacing for the x and y coordinates is in centimeters and can be typed or 

entered using the increment / decrement buttons. The visible spacing determines which grid lines 

are visible. A value of 1 indicates that all grid lines are visible, 2 indicates that every second line 

is visible, and so on. Note that the snapto- grid works the same whether or not grid lines are 

visible. The Hex grid checkbox allows you to create a grid of hexagons instead of squares. The 

Hex grid size is also in centimeters. The snap-to-grid feature may be toggled on and off using the 

snap-to-grid button located below the canvas. When this is enabled, objects are forced to align on 

a grid line. 

 

3.3. Rulers 

Rulers appear on the top and the left of the Dia canvas. They show, in centimeters, how large 

your canvas is. A centimeter on the screen will not necessarily equal an actual centimeter. This 

will depend on your monitor's dots-per-inch (DPI) setting and your current zoom percentage. For 

example, if your monitor is set to 96 DPI and your zoom percentage is about 185%, then the 

display ruler is at actual scale. Regardless of these settings, you can always see how big your 

objects and diagram are using the 

on-screen ruler. 
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3.4. Background Color 

The background color option allows you to change the color of the canvas. By default, the color 

is white. However, the color can be changed by selecting Diagram -> Properties and then 

selecting the "Colors" tab. The first color option is Background. You can change the color by 

selecting the drop-down list box and then using the standard color selection options. See Objects 

/ Colors for more information about selecting colors. 

 

Note 

The gridlines will change their color automatically to stay visible if the background color 

is changed to black. 

 

3.5. Zooming 

Zooming allows the user to zoom in (make things bigger) or zoom out (make things smaller). 

Zooming in is useful when you are trying to make your drawing very precise. Zooming out is 

useful when you want to view a larger portion of the diagram. 

The canvas can be zoomed in to 2500% and out to 5%. Zooming can be done in several ways. 

The Toolbox contains a Magnify tool.  If you select the Magnify tool and then click anywhere on 

the canvas, the diagram is zoomed in at that point by a factor of two (e.g., from 100% to 200%). 

Shift+Click reverses the process (i.e., zooms out by a factor of two). 

 

 

3.6. Other View Menu Option 

 

 

In addition to the zoom options discussed above, the View menu provides a number of useful 

functions. 

These are discussed below. 

• Fullscreen (F11) toggles between the normal window view and full-screen view. 

• AntiAliased toggles the antialiased feature on and off. 

• Show Grid toggles the display of the grid on and off. 

• Snap To Grid toggles the snap-to-grid property on and off. 

• Snap To Objects toggles the snap-to-objects property on and off. When this is on, lines can be 

connected to the middle connection point of an object by dragging the line end handle to any 

point inside the object. When this is off, the line's connection handle must be dragged to the 

middle connection point of the object being connected. 

• Show Rulers toggles the ruler display on and off. 

• Show Connection Points toggles the connection points display on and off. 

• New View opens a new window that displays the same diagram. This can be useful if you want 

to see and work on different sections of a diagram at the same time. 
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3.7. Undo and Redo 

 

Dia supports Undo and Redo on most operations. To undo an operation, press Ctrl+Z or select 

Edit- 

>Undo from the diagram menu bar. To redo an operation, press Ctrl+Shift+Z or select Edit-

>Redo from 

the diagram menu bar. 

 

 

Chapter 4. Objects and the Toolbox 

 

A diagram in Dia consists of a set of objects. Objects are shapes that are either predefined or 

user-defined. 

The Toolbox allows you to select the desired object and allows you to set default properties for 

objects. 

 

4.1. Dia Toolbox Overview 

When Dia is executed, two windows open: the canvas, which contains the diagram, and the 

Toolbox, which contains the object palettes and other controls. The Toolbox is divided into three 

regions. The top region contains 14 buttons. The first three are controls used to adjust the 

diagram. The next 11 are the icons for the built-in basic objects. 

The middle portion of the Toolbox contains the selected Special Objects. This is used to select 

among the many built-in object sheets supplied with Dia, such as UML, Flowchart, Network, etc. 

The bottom portion of the Toolbox contains special controls that set default properties for objects 

placed on the canvas. These include foreground color, background color, and line width. There 

are also three controls that set the default properties for line objects. These are beginning arrow 

style, ending arrow style, and line style. 

 

. 

4.2. Using Objects 

 

4.2.1. Adding Objects 

Adding objects to the Dia canvas is done by clicking on the desired object's icon button in the 

Toolbox and then clicking on the canvas at the desired insertion point. The selected object will 

be inserted at that point. 

 

 

 

 

4.2.2. Moving Objects 

 

When an object is inserted into the canvas, the desired object will appear with small green boxes 

(known as handles) around the border. 

To move an object, click anywhere inside the object (or somewhere on a line other than a handle) 

and drag the mouse to the desired location on the canvas. For line objects, you need to click on 

the line. Objects and the Toolbox 
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4.2.3. Resizing Objects 

 

Handles are used to change the size of the object. To expand an object, just click a handle and 

drag it away from the center of the object. To shrink an object, drag a handle toward its center. 

The object's size will change as you drag the mouse. If an object has a fixed aspect ratio, 

changing one dimension automatically changes the other. If an object has a free aspect ratio, you 

can change one dimension (e.g., height) without affecting the other (e.g., width). Some objects 

have a property setting that determines whether the aspect ratio is fixed or free. 

 

4.2.4. Deleting Objects 

 

To delete an object, click on the object to select it. The handles will display, which indicates that 

the object is selected. Then press the Delete key or select Edit->Delete from the menu. 

 

4.2.5. Connecting Objects With Lines 

 

In many diagrams, shapes are connected to each other using one of the basic line objects. When a 

shape is not selected, a number of connection points are displayed on its borders as small "x" 

figures. There is also a connection point in the middle of each shape. Lines also have connection 

points where other lines can connect. Lines have handles on each end that are used to connect 

them to other objects. These handles are green if the line is not connected and red if it is 

connected. Lines also have orange handles that are used to shape the line. The figure below 

shows several lines with green handles on the unconnected end and red handles on the connected 

end. 

 

4.2.6. Entering Text 

 

Text can be entered by selecting the object, entering text edit mode and then typing the text. The 

font, size, alignment, and other formatting properties can be changed by double-clicking the 

object, when not in text edit mode. Many Dia objects suport in-canvas editing of text. Dia 

versions before 0.97 had not explicit distinction between a selected object and it's text edit mode. 

As a result numerous workarounds were needed to support canvas and text editing with the same 

set of keys, e.g. the Delete key was not deleting the character right to the cursor, but instead the 

whole object. With Dia 0.97 and later there is a dedicated text edit mode. You can enter it by 

hitting Enter or F2 key while an appropriate object is selected. To leave text editing just click 

outside of the editable area or hit the Escape key. 

 

 

4.2.7. Aligning Objects 

 

Dia provides several options to help arrange multiple objects without needing to move each 

object individually. These are available on the Objects->Align menu choice shown below. 
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4.2.7.1. How To Align Objects 

 

To align objects, first select the objects to align (see Selecting Objects ) and then execute one of 

the align commands, using either the menu or the shortcut key. The order in which objects are 

selected does not matter. 

 

4.2.7.2. Left, Center, and Right Align 

 

The align left, right, and center are used to align objects arranged vertically on the canvas. The 

align left aligns the selected objects to the left edge of the left-most object. Similarly, the align 

right aligns the selected objects to the right edge of the right-most object. Align center aligns the 

center of each object to the mid-point between the extreme left and extreme right edge of all 

selected objects 

 

4.2.7.4. Spread Out Horizontally and Vertically 

 

The Align / Spread Out commands can be used to create uniform spacing for objects arranged 

either horizontally or vertically. Examples of these commands are shown below. 

 

4.2.7.5. Align Adjacent or Stacked 

 

The Align / Adjacent command is used to place objects next to each other with no horizontal 

space in between. The Align / Stacked is used to place objects directly on top of each other, with 

no vertical space in between.  

 

Chapter. Basic Objects 

 

1. Basic Objects Introduction 

 

Dia has a dozen basic objects: Text, Box, Ellipse, Polygon, Beziergon, Line, Arc, Zigzagline, 

Polyline, Bezierline, Image and Outline. 

 

1.1. Text 

 

Dia supports the use of text as its own type of object. Text can be placed on the canvas by 

clicking on the text button on the toolbox. For tips on editing text, see Entering Text in the Using 

Objects chapter. 

 

 

 

1.2. Box 

The boxes in Dia can be customized to be any size desired by the user. The properties available 

are: 

• Corner Rounding - Causes the corners to be rounded instead of hard edges. 

• Draw Background - Keeps the center clear or fills with the background color. 
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1.3. Ellipse 

An ellipse is a shape which has all rounded sides, such as a circle or an oval. 

 

1.4. Polygon 

 

A polygon is any closed shape made up of straight lines. The polygon tool, allows the user to 

draw any shape with all straight lines. 

 

1.5. Beziergon 

 

A beziergon is similar to the polygon as the user defines the shape. However, it differs in that it 

allows curves to exist in the shape. 

 

1.6. Line 

A Line is a simple straight line. Unlike the other lines, the simple Line does not have any handles 

to allow the shape to be altered. It just has two connection handles, one at each end. 

 

1.7. Arc 
An Arc is a line which has been bent to create a semi-circle shape. Drag the orange handle in the 

middle to alter the curve of the arc. 

 

1.8. Zigzagline 

A Zigzagline is a line which has sharp, 90 degree turns in it. Zigzaglines have two special 

properties, Corner radius and Autoroute. Corner radius allows you to round the corners of the 

line.  Zigzaglines also allow you to add or delete line segments. This can be useful if you need 

the line to turn several corners (e.g., to traverse around some other objects) or to get the arrow 

pointed in the right direction. To add or delete a segment, right-click on the line at the point on 

the line where you want to add or delete and select Add segment or Delete segment. 

 

Flowchart 

A group dedicated to providing the user shapes which are commonly used in flow charts. Flow 

charts can be routinely found in computer programming, marketing, economics, and any other 

semi-linear operation which requires planning. Most flowchart objects allow entry of text. 

 

Organizing Sheets and Objects 

 

It is possible to modify the way objects are grouped into sheets. Say, for example, that most of 

the object you need are on one sheet but you also need some objects from a second sheet. To 

keep everything you need on one sheet, you can copy objects from one sheet to another as 

follows: 

1. On the Toolbox menu, select File->Sheets and Objects.  

2. Using the drop-down listbox on the left side, select the sheet you want to copy from. On the 

right, 

select the sheet you want to copy to. 

3. Click on the object you wish to copy on the left side and press the Copy button. 
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4. Repeat for any other objects you want to copy. When you are done, press the Apply button on 

the 

bottom to save your changes. 

From now on, the new objects will be listed on the sheet on the right. You can also remove 

objects from 

sheets and move objects from one sheet to another. You can also use the Up and Down buttons 

to change 

the order of the objects within a sheet. 

 

Flowcharts made by using DIA: 
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Aim: LIBRE OFFICE  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

WHAT IS A WRITER? 

 

Writer is the word processor component of LibreOffice. In addition to the usual features of a word 

processor (spelling check, thesaurus, hyphenation, autocorrect, find and replace, automatic 

generation of tables of contents and indexes, mail merge, and others), Writer provides these 

important features: 
• 

• 

• 

• 

• 

• 

• 

• 

• 

Templates and styles (see Chapters 6 and 7) 

Page-layout methods, including frames, columns, and tables (Chapter 4) 

Embedding or linking of graphics, spreadsheets, and other objects (Chapter 8) 

Built-in drawing tools (Chapter 8) 

Master documents, to group a collection of shorter documents into a single long document 

(Chapter 13) 

Change tracking during revisions (Chapter 3) 

Database integration, including a bibliography database (Chapters 11, 12, 15) 

Export to PDF, including bookmarks (Chapter 5) 

And many more 
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INTRODUCTION ON WORKING WITH TEXT 

Inserting special character 

 

 

A special character is one not found on a standard English keyboard. For example, © ¾ æ ç Ł ñ ö 

ø ¢ are all special characters. To insert a special character: 

    1) Place the cursor in your document where you want the character to appear. 

    2) Click Insert > Special Character to open the Special Characters dialog. 

    3) Select the characters (from any font or mixture of fonts) you wish to insert, in order; then 

click OK. The selected characters are shown in the lower left of the dialog. As you select each 

character, it is shown on the right, along with the numerical code for that character. 

 

 

. 

. 

This chapter covers the basics of working with text in Writer, the word-processing component of 

LibreOffice. It assumes that you are familiar with the use of a mouse and keyboard and that you 

have read about Writer’s menus and toolbars and other topics covered in Chapter 1, Introducing 

Writer. 

We recommend that you also follow the suggestions in Chapter 2, Setting up Writer, about 

displaying formatting aids, such as end-of-paragraph marks, and selecting other setup options. 

When you have read this chapter, you should know how to: 

• 

• 

• 

• 

• 

• 

• 

• 

• 

Select, cut, copy, paste, and move text 

Find and replace text 

Insert special characters 

Format paragraphs and characters 

Create numbered or bulleted lists 

Check spelling and grammar, use the thesaurus, and choose hyphenation options 

Use the autocorrection, word completion, autotext, and line numbering features 

Track changes, undo and redo changes, and insert comments 

Link to other parts of a document 
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